Договор № 

г. Барнаул                                                                                                                                                   «____» ______________ 2021 г.

Открытое акционерное общество «Алтайский дом печати», именуемое в дальнейшем «Исполнитель», в лице Генерального директора Беляева Александра Вениаминовича, действующего на основании Устава, с одной стороны и _____________________________________________________________________________________________________________, именуемое в дальнейшем «Заказчик», в лице ____________________________________________________________, действующего на основании _____________________________, с другой стороны, далее совместно именуемые «Стороны», заключили настоящий Договор о нижеследующем:

1. Предмет Договора
1.1. Исполнитель обязуется по заданию Заказчика лично и/или с привлечением третьих лиц изготовить и передать в собственность полиграфическую продукцию (далее — «Продукция»), а Заказчик обязуется принять и оплатить Продукцию. 
1.2. Исходные материалы Заказчика для изготовления Продукции, принимаются Исполнителем в соответствии с техническими требованиями «Требования к исходным материалам Заказчика» (Приложение № 2). 
1.3. Наименование, цена, количественные и качественные характеристики Продукции, условия упаковки и доставки, сроки изготовления, а также порядок и сроки оплаты Продукции согласовываются Сторонами в соответствующих Спецификациях (Приложение № 4), являющихся неотъемлемой частью настоящего Договора.
1.4. Оценка качества продукции, изготовленной в соответствии с подписанными сторонами оригинал-макетами, производится согласно стандартам Исполнителя «Критерии оценки качества полиграфической продукции» (Приложение № 3).

2. Права и обязанности Сторон 
Заказчик обязуется:
2.1. Передать Исполнителю исходные материалы: 
·    макет в электронном виде;
· распечатку макета, подписанную Заказчиком или сообщение на почту Исполнителя с подтверждением об утверждении прикрепленного к сообщению файла;
· подписанный Заказчиком макет готового изделия
в течение 3 (трех) рабочих дней с момента подписания Спецификации.
При предоставлении Заказчиком исходных материалов, не соответствующих «Требованиям к исходным материалам Заказчика», существенные условия выполнения заказа — срок изготовления и цена, указанные в Спецификации, — могут быть изменены.
2.2. Заказчик гарантирует, что он обладает правами на переданные им для изготовления Продукции исходные материалы, являющиеся результатами интеллектуальной деятельности или приравненными к ним средствами индивидуализации  юридических лиц, товаров, работ, услуг и предприятий, которым предоставляется правовая охрана в соответствии с ч. IV Гражданского Кодекса Российской Федерации, (в том числе произведения, дизайны, макеты, рисунки, фотографии, текст, товарные знаки и знаки обслуживания, полезные модели, фирменные наименования,  коммерческое обозначение и т.п.). Заказчик гарантирует, что указанные исходные материалы переданные Исполнителю для изготовления продукции приобретены или созданы и используются им добросовестно, на основании закона или договора и без нарушения прав третьих лиц. 
В случае предъявления к Исполнителю третьими лицами любых претензий по поводу неправомерности использования исходных материалов (содержащихся в них сведений) с нарушением любых прав третьих лиц Исполнитель обязан немедленно сообщить об этом Заказчику для урегулирования возникших претензий.
Если претензии/требования третьего лица окажутся обоснованными, Заказчик обязуется удовлетворить их своими силами и за свой счет, а также возместить Исполнителю убытки, связанные с незаконным использованием прав на результаты интеллектуальной деятельности.
2.3. Предоставить Исполнителю право на использование исходных материалов, охраняемых в соответствии с законодательством РФ как результат интеллектуальной деятельности и средства индивидуализации для изготовления Исполнителем Продукции, согласованной сторонами в соответствующей спецификации к договору и сроком использования прав не позднее даты передачи Продукции Заказчику. Передача указанных в настоящем пункте прав осуществляется в момент получения Исполнителем исходных материалов. Право на использование исходных материалов, охраняемых в соответствии с законодательством РФ как объекты права интеллектуальной собственности, предоставляется Заказчиком Исполнителю безвозмездно. 
2.4. Принять изготовленную Исполнителем Продукцию в соответствии с разделом 4 настоящего Договора и в сроки, указанные в Спецификации.
2.5.    Оплатить стоимость Продукции в сроки и порядке, указанном в Спецификации.
 2.6. Подписать в момент передачи Продукции от Исполнителя Заказчику Универсальный передаточный документ (УПД) и вернуть его уполномоченному представителю Исполнителя.
 В случае иногородней поставки Продукции Заказчик обязан вернуть Исполнителю Универсальный передаточный документ (УПД), подписанный уполномоченным лицом Заказчика в течение 3 (трех) рабочих дней с момента получения Заказчиком Продукции и товаросопроводительных документов. В случае если Заказчик не выполнит данное условие, обязательства Исполнителя считаются выполненными в полном объеме, а подписанный в одностороннем порядке Универсальный передаточный документ (УПД) с приложенной распиской экспедитора о получении Продукции —надлежащим образом оформленным.
Заказчик имеет право:
2.7.   Ознакомиться с пробными образцами Продукции, изготовленной Исполнителем.
2.8. Предоставить Исполнителю право на демонстрацию созданной им Продукции в следующих целях: демонстрировать в качестве образца своих услуг иным Заказчикам, использовать в портфолио сотрудников Исполнителя и на сайте Исполнителя, предоставлять образец Продукции на фестивали и конкурсы — путем подписания Спецификации.
Исполнитель обязуется:
2.9. По заданию Заказчика после получения исходных материалов изготовить Продукцию надлежащего качества, согласно установленным «Критериям оценки качества полиграфической продукции» (Приложение № 3) на условиях, указанных в Спецификации (Приложение № 4).
2.10. По согласованию с Заказчиком оказывать дополнительные услуги, необходимые для изготовления Продукции. Условия оплаты и сроки оказания дополнительных услуг определяются Сторонами в отдельной Спецификации.
2.11. Организовать доставку Продукции способом, согласованным с Заказчиком и указанным в Спецификации.
Исполнитель имеет право:
2.12. Перенести сроки исполнения задания Заказчика в случае отсутствия исходных материалов и/или нарушения сроков их предоставления Заказчиком. Сроки изготовления Продукции переносятся Исполнителем с учетом графика загрузки производственных мощностей Исполнителя и дополнительно согласовываются по усмотрению Сторон в письменном виде.

3. Цена Договора, порядок расчетов
3.1. Цена на Продукцию (партию Продукции) устанавливается по соглашению Сторон и указывается в соответствующей Спецификации. Порядок расчёта, включая периодичность платежей, также определяется Сторонами в Спецификации.
3.2. Расчёт производится посредством перечисления денежных средств Заказчиком на расчётный счёт Исполнителя, либо иным другим способом, не противоречащим Законодательству РФ.
3.3. Датой оплаты считается дата поступления денежных средств на расчётный счет Исполнителя, дата поступления денежных средств в кассу Поставщика, либо дата поступления документов, удостоверяющих погашение задолженности за поставляемую Продукцию.
3.4. Исполнитель имеет право при наличии за Заказчиком дебиторской задолженности по ранее произведенным отгрузкам, вне зависимости от оснований её возникновения, средства, поступившие от Заказчика или других плательщиков за него, засчитать в первую очередь в счет погашения ранее возникшей задолженности, при этом назначение платежа, указанное в платежном поручении, во внимание не принимается.


4. Порядок приемки Продукции по количеству и качеству
4.1. Продукция, являющаяся предметом настоящего Договора, принимается Заказчиком по количеству и качеству. Приемка оформляется Универсальным передаточным документом (УПД). 
4.2.  Приемка Продукции производится лицами, уполномоченными на то руководителем Заказчика. Указанные лица несут ответственность за соблюдение порядка приемки Продукции. 
4.3.  Приемка Продукции по количеству осуществляется путем пересчета ненарушенных тарных мест при ее получении Заказчиком.
Приемка Продукции по количеству на предмет внутритарной недостачи и по качеству (по внешнему виду) осуществляется Заказчиком в течение 15 (пятнадцати) рабочих дней с момента ее доставки и передачи Заказчику. 
В случае выявления принимающими лицами несоответствия Продукции по количеству на предмет внутритарной недостачи и качеству, Заказчик в течение трёх рабочих дней письменно уведомляет Исполнителя об этом факте и составляет Акт об установленном расхождении по количеству и качеству, а так же претензию, в которой указывает характер установленных нарушений, расхождений и предложения по их урегулированию.
Претензии по недостаткам, которые не могли быть обнаружены при обычной для данного вида продукции проверке и выявлены лишь в процессе ее обработки (скрытые недостатки) должны быть составлены в течение трёх дней с момента обнаружения указанных недостатков, однако не позднее трёх месяцев со дня поступления продукции на склад Заказчика, при условии соблюдения «Условий хранения и транспортировки» (Приложение № 1).
   4.4. Моментом возникновения права собственности на Продукцию у Заказчика признается: 
· при самовывозе — момент передачи Продукции Заказчику на складе Исполнителя и подписания уполномоченными лицами Сторон Универсального передаточного документа (УПД);
· при доставке Продукции транспортом Исполнителя на склад Заказчика — момент передачи Продукции Заказчику на складе последнего и подписания уполномоченными лицами Сторон Универсального передаточного документа (УПД);
· При доставке Продукции силами привлеченного Исполнителем Экспедитора – момент передачи Продукции от Экспедитора представителю Заказчика и подписанием уполномоченным представителем Заказчика документов Экспедитора о передаче груза.
· при доставке Продукции силами привлеченного Заказчиком Экспедитора — момент передачи Продукции Исполнителем представителю Экспедитора для доставки Заказчику и подписания уполномоченными лицами Сторон соответствующих документов. Подтверждением полномочий представителя Экспедитора, имеющего договорные отношения с Заказчиком, является доверенность от Заказчика, соответствующая требованиям ст. 185 ГК РФ или по форме № М-2.
 4.5. Процент несоответствующих (некачественных) единиц продукции не должен превышать 0,50% (Ноль целых пять десятых процента) от общего числа единиц продукции в каждой партии (поставляемой в рамках каждой Спецификации). В случае если процент несоответствующих (некачественных) единиц ниже указанного выше показателя, то вся продукция принимается Заказчиком в полном объеме без предъявления к Исполнителю каких-либо санкций.
4.6. Фактически поставляемое количество единиц продукции может отличаться от числа единиц продукции, определенного в каждой партии (поставляемой в рамках каждой Спецификации) на 10% (Десять процентов) в любую сторону. При этом Заказчик принимает продукцию в количестве равном фактическому количеству продукции без предъявления к Исполнителю каких-либо санкций. Заказчик принимает и оплачивает фактически полученное количество единиц продукции. Если фактически поставляемое количество единиц продукции меньше числа единиц, определенного в каждой партии (поставляемой в рамках каждой Спецификации), то у Исполнителя нет обязанности в дополнительной поставке Заказчику недостающего числа единиц продукции.


5. Ответственность Сторон
5.1. За неисполнение или ненадлежащее исполнение любого из своих обязательств по настоящему Договору каждая из Сторон несет ответственность, предусмотренную действующим законодательством Российской Федерации и Договором. 
5.2. Ответственность Исполнителя:
В случае изготовления Продукции с дефектами, неточностями или повреждениями, не соответствующей «Критериям оценки качества полиграфической продукции» (Приложение № 3), и/или имеющей расхождения по количеству, за исключением количества, согласованного Сторонами в п. 4.5., Заказчик вправе потребовать от Исполнителя осуществления одного из следующих действий:
· замены экземпляров Продукции с дефектами, неточностями или повреждениями на экземпляры Продукции надлежащего качества и/или допоставки недостающих экземпляров в течение 10 (десяти) рабочих дней с момента предъявления претензии или в иной срок, согласованный Сторонами;
· соразмерного уменьшения стоимости Продукции;
· предоставления недостающего количества Продукции в следующей поставке.        
5.3. Исполнитель не несет ответственность:
· за содержание предоставленных Заказчиком исходных материалов;
· за нарушение интеллектуальных прав третьих лиц, в случае если будут предъявлены претензии или иски по поводу нарушения таких прав в связи с использованием исходных материалов, являющихся результатами интеллектуальной деятельности и приравненными к ним средствами индивидуализации юридических лиц, товаров, работ, услуг и предприятий, предоставленных Заказчиком для изготовления Продукции Исполнителем. Заказчик несет ответственность 
· по указанным претензиям третьих лиц к Исполнителю, поскольку нарушение интеллектуальных прав в таком случае может произойти только по вине Заказчика в связи с неисполнением им п. 2.2. настоящего Договора;
за нарушение прав третьих лиц, в случае если будут предъявлены претензии или иски по поводу нарушения таких прав в связи с использованием исходных материалов, охраняемых как результат интеллектуальной деятельности, предоставленных Заказчиком для изготовления Продукции Исполнителем, Заказчик принимает на себя всю ответственность по всем претензиям третьих лиц к Исполнителю;
5.4. В случае нарушения сроков выполнения обязательств, принятых по настоящему Договору, сторона, нарушившая сроки выполнения обязательства, по письменному требованию стороны, чьи интересы были нарушены, уплачивает последней пеню в размере 0,05% от суммы ненадлежащим образом исполненного обязательства за каждый день нарушения срока исполнения обязательства. Требование уплаты пени является правом, но не обязанностью пострадавшей стороны.




6. Антикоррупционная оговорка
[bookmark: Par2]6.1. При исполнении своих обязательств по настоящему Договору Стороны, их аффилированные лица, работники или посредники не выплачивают, не предлагают выплатить и не разрешают выплату каких-либо денежных средств или ценностей, прямо или косвенно, любым лицам для оказания влияния на действия или решения этих лиц с целью получить какие-либо неправомерные преимущества или для достижения иных неправомерных целей.
[bookmark: Par3]6.2. При исполнении своих обязательств по настоящему Договору Стороны, их аффилированные лица, работники или посредники не осуществляют действия, квалифицируемые применимым для целей настоящего Договора законодательством как дача/получение взятки, коммерческий подкуп, а также иные действия, нарушающие требования применимого законодательства и международных актов о противодействии коррупции.
[bookmark: Par4]6.3. В случае возникновения у Стороны подозрений, что произошло или может произойти нарушение каких-либо положений п. п. 6.1 и 6.2 настоящего Договора, соответствующая Сторона обязуется уведомить об этом другую Сторону в письменной форме. В письменном уведомлении Сторона обязана сослаться на факты или предоставить материалы, достоверно подтверждающие или дающие основание предполагать, что произошло или может произойти нарушение каких-либо положений п. п. 6.1 и 6.2 настоящего Договора другой Стороной, ее аффилированными лицами, работниками или посредниками.
6.4. Сторона, получившая уведомление о нарушении каких-либо положений п. п. 6.1 и 6.2 настоящего Договора, обязана рассмотреть уведомление и сообщить другой Стороне об итогах его рассмотрения в течение 5 (пяти) рабочих дней с даты получения письменного уведомления.
6.5. Стороны гарантируют осуществление надлежащего разбирательства по фактам нарушения положений п. п. 6.1 и 6.2 настоящего Договора с соблюдением принципов конфиденциальности и применение эффективных мер по предотвращению возможных конфликтных ситуаций. Стороны гарантируют отсутствие негативных последствий как для уведомившей Стороны в целом, так и для конкретных работников уведомившей Стороны, сообщивших о факте нарушений.
6.6. В случае подтверждения факта нарушения одной Стороной положений п. п. 6.1 и 6.2 настоящего Договора и/или неполучения другой Стороной информации об итогах рассмотрения уведомления о нарушении в соответствии с п. 6.3 настоящего Договора, другая Сторона имеет право расторгнуть настоящий Договор в одностороннем внесудебном порядке путем направления письменного уведомления не позднее чем за 10 (десять) календарных дней до даты прекращения действия настоящего Договора.

7. Заключительные положения
7.1. Изменения и дополнения к настоящему Договору действительны, если они совершены в письменной форме и подписаны от имени обеих Сторон уполномоченными на то, лицами.
7.2. Все споры по настоящему договору решаются путем переговоров, претензионный порядок обязателен. Срок рассмотрения претензии — не более 5 (пяти) рабочих дней с момента ее получения.
7.3. Споры подлежат рассмотрению в Арбитражном суде Алтайского края.
7.4. Взаимоотношения Сторон, не урегулированные настоящим Договором, регламентируются действующим законодательством Российской Федерации.
7.5. Настоящий Договор вступает в силу с момента подписания обеими Сторонами и действует до 31.12.2021 г. В случае если за 14 (четырнадцать) календарных дней до истечения срока действия настоящего Договора ни одна из Сторон не заявит о своем намерении расторгнуть настоящий Договор, последний считается пролонгированным на каждый последующий год. Количество пролонгаций не ограничено. Прекращение Договора не означает прекращение обязательств Сторон, вытекающих из уже осуществленных обязательств, и не означает отказа от защиты прав, включая судебную защиту, в случае нарушения другой  стороной обязательств, вытекающих из настоящего Договора.
7.6. Настоящий Договор составлен в двух экземплярах, имеющих равную юридическую силу, по одному для каждой из Сторон.
7.7.  Настоящий договор, приложения, а также иные документы, касающиеся его заключения и исполнения, подписанные уполномоченными представителями Сторон и переданные по факсимильной связи или электронной почтой, имеют юридическую силу до момента предоставления оригиналов и могут служить доказательствами в суде. Стороны в обязательном порядке направляют друг другу надлежаще оформленные оригиналы вышеупомянутых документов в течение 21 (двадцати одного) рабочего дня с момента оформления соответствующих документов.
7.8.  В случае изменения своих банковских, отгрузочных реквизитов и юридического и фактического адресов местонахождения Стороны обязаны известить об этом друг друга в течение 5 (пяти) рабочих дней.
7.9. Письменные претензии сторон к друг другу, а также иные документы, имеющие отношение к настоящему договору должны направляться по почте заказным письмом. Датой получения претензии является дата вручения заказного письма почтовой организации адресату. При этом если документ, направленный одной из сторон по последнему известному ей адресу для корреспонденции другой стороны, вернулся первой стороне по причине отсутствия  второй стороны по этому адресу или ее отказа от получения этого документа, или не явился за его получением,  документ считается  полученным второй стороной в день проставления почтовой службой на конверте отметки «адресат выбыл», «от получения отказался» или аналогичной отметки, а если такая отметка отсутствует или день ее проставления определить невозможно  - то в день получения первой стороной возвращенного документа.
7.10. Каждая из сторон заключила настоящий Договор, основываясь на достоверности, актуальности и полноте следующих сведений, сообщенных ей перед его заключением представителем другой стороны, подписывающим Договор:
- другая сторона является действующим юридическим лицом, в отношении нее не принято решение о ее ликвидации или о признании ее несостоятельной (банкротом);
- представитель другой стороны имеет все полномочия, необходимые для заключения им Договора от ее имени;
- не существует никаких других зависящих от другой стороны правовых препятствий для заключения и исполнения ею Договора;
- другая сторона является плательщиком НДС и ведет бухгалтерскую и налоговую отчетность в соответствии с требованиями действующего законодательства РФ.
	Все предусмотренные данным пунктом Договора сведения имеют существенное значение, в связи с чем, если окажется, что они не соответствуют действительности, основывавшаяся на них сторона вправе требовать признания настоящего Договора недействительным по причине заключения его под влиянием заблуждения или обмана, а также возмещения причиненных убытков.
Приложения к настоящему Договору:
1. Условия хранения и транспортировки (Приложение № 1);
2. Требования к исходным материалам Заказчика (Приложение № 2);
3. Критерии оценки качества полиграфической продукции (Приложение № 3);
4. Форма Спецификации к Договору (Приложение № 4).



8. Реквизиты и подписи Сторон
	           
Исполнитель:
ОАО «Алтайский дом печати»
656043 г. Барнаул, ул. Б. Олонская, 28
Сибирский филиал АО «Банк Интеза»
р/с 40702810660090002987
к/с 30101810250040000883
г. Новосибирск, БИК 045004883
ОГРН 102220767103
ИНН 2225004671, КПП 222501001
ОКОНХ 19400, ОКПО 02425206
адрес эл.почты:




Генеральный директор:


____________________   А.В. Беляев

м.п.
	
Заказчик:

















____________________   
                              
  м.п.



Приложение № 1
к Договору №____ от
 «___» ________________ 2021 г.


УСЛОВИЯ ХРАНЕНИЯ И ТРАНСПОРТИРОВКИ

Условия транспортировки:
Транспортировка готовой продукции проводится всеми видами транспорта в чистых, сухих, крытых транспортных средствах в соответствии с правилами и нормами перевозки, действующими на данном виде транспорта. При транспортировке, складировании и хранении продукции, ее следует беречь от ударов, не бросать, беречь от влаги и воды, не допускать нарушения целостности упаковки и маркировки тары.
Условия хранения:
Коробки в гофротаре должны храниться в штабеле высотой не более 1,8 м в сухих закрытых помещениях, защищенных от атмосферных осадков и почвенной влаги с естественной вентиляцией, на расстоянии не менее 1 м от отопительных приборов, вдали от прямых солнечных лучей, при t 10-25° С, при относительной влажности воздуха 40-60 %. Расстояние между штабелем и полом склада должно быть не менее 100 мм. Изделия нельзя хранить рядом с сильно пахнущими, ядовитыми и агрессивными веществами.
Обращаем внимание, в случае нарушения условий хранения Продукции, возможно проявление следующих нежелательных дефектов:
· слеживание продукции, и, как следствие, сложности при срабатывании продукции на высокоскоростном автоматическом фасовочном оборудовании;
· деформация изделия, и, как следствие, нарушение конструкции пачки;
· изменение цвета изделия (особенно для пастельных тонов) вследствие не стабильности офсетных печатных красок, содержащих в своем составе более 90% кроющих белил;
· ухудшение качества лакового слоя, вырубки, тиснения и склейки, особенно при наличии значительных перепадов температур и относительной влажности в процессе хранения.
В случае нарушения условий хранения и транспортировки, а также в случае видимого нарушения целостности упаковки и маркировки тары, Исполнитель не несет перед Заказчиком ответственности за качество продукции.
Риск случайной гибели или повреждения Продукции (партии Продукции) переходит от Исполнителя к Заказчику с момента передачи Исполнителем Продукции согласно товарной накладной.




ПОДПИСИ СТОРОН

	от Исполнителя

_______________________/А.В.Беляев/
                         М.П.


	от Заказчика

_____________________ / _______________/                            
                      М.П.







Приложение № 2
к Договору №____ от
 «_____» _______________ 2021 г.

			
Требования к исходным материалам Заказчика

1. Перечень предоставляемых Заказчиком исходных материалов
Для исполнения задания Исполнителем по изготовлению полиграфической Продукции Заказчик обязан предоставить исходные материалы:
1. макет в электронном виде;
1. распечатку макета, подписанную Заказчиком;
1. подписанный Заказчиком макет готового изделия.

1. Основные требования ОАО «Алтайский дом печати» к приему исходных материалов в печать
Предполагается, что все исходные материалы подготовлены с учетом данных технических требований и не требуют никаких правок. Обращаем ваше внимание, что исходные материалы, не соответствующие техническим требованиям, могут привести к браку в процессе печати и послепечатной обработки. Отдел допечатной подготовки проводит проверку материалов на соответствие техническим требованиям, но не гарантирует обнаружения всех ошибок и несоответствий. Отдел допечатной подготовки сообщает об обнаруженных ошибках и дает рекомендации по их устранению. В отдельных случаях возможна доработка макета до соответствия техническим требованиям, сроки и стоимость доработки оговариваются отдельно. 
Электронные носители. 
Электронные оригинал-макеты принимаются на следующих носителях:
· на внешних накопителях, подключаемых к USB со шнурами и не требующих дополнительных драйверов;
· макет можно выслать по e-mail или через файлообменник, а также через облачный сервис с предоставлением доступа для скачивания.
Форматы электронных документов, принимаемых в производство:
· PDF. Файлы предоставляются в формате PDF/X-1a. 
· EPS, TIFF, JPEG, PSD (Grayscale/CMYK/ Multichannel, 8 бит). Растровые изображения (CMYK) должны быть переделены через цветовой профиль — Coated FOGRA39, а черно-белые (Grayscale) — Dot Gain 15%.
· Adobe InDesign CS – CS5 (PC), Adobe Illustrator 7.0 – CS5*.eps (PC), CorelDRAW 5.0 – X3 (PC).
PDF-файлы — это наиболее предпочтительный формат для передачи материалов. (Рекомендуется)
Для многостраничных изданий обложку необходимо дублировать - предоставлять PDF и исходный файл в той программе, в которой он был изготовлен (для корректировки корешка).

Если в этом списке не оказалось программы, используемой вами при подготовке публикации, то необходимо связаться со специалистами допечатной подготовки типографии для корректной записи файлов.

Файлы поддержки.
К публикации должны быть приложены все необходимые файлы поддержки: шрифты, графические файлы. Приносите только те шрифты, которые использованы в публикации. 
Все шрифты должны быть представлены в следующих форматах:
· PostScript Type 1 – *.pfb (Printer Font Binary) + *.pfm (Printer Font Metrics);
· TrueType *.ttf (TrueType Font).

1. Основные требования к макетам
Наличие распечатки с указанием формата изделия, спецотделки, вырубных контуров и т.д.
При отсутствии у Заказчика на момент сдачи файлов для спецотделок (тиснение, конгрев. Уф-лака и других видов), они утверждаются дополнительно в процессе подготовки с менеджером типографии.
Размеры и допуски.
1. Размер готового изделия, а также поля под подрезку должны быть четко обозначены в файле -направляющими или блидами (установки в настройках параметров страницы/листа).
2. В макете должны быть учтены поля на подрезку не менее 2 мм.
Для многостраничного макета (журнал/книга и т.п.). В макете должны быть учтены поля на подрезку по трем внешним сторонам (сверху, снизу, снаружи) – не менее 3 мм (для термоклеевого скрепления). При скреплении на скрепку внешнее поле на подрезку должно быть не менее 5 мм. Расстояние от значащих элементов (колонтитулы, текст, логотипы) до края изделия, биговок должно быть не менее 5 мм, перфорации - не менее 8 мм, в корешке — не менее 15 мм. Если они не смакетированы «под обрез» («на вылет»).
3.  На обложке корешок рассчитывается исходя из толщины внутреннего блока и толщины материала обложки. Для расчета корешка необходимо связаться с менеджером. Обложку следует предоставлять в редактируемом формате, чтобы имелась возможность корректировать ширину корешка.
4. Не рекомендуется придавать корешку четкие границы.
5. Следует учесть, что от края корешка до биговки 7 мм.
6. Для изделий на КБС в случае необходимости состыковки изображения на обложке и первой страницы блока (обложки и последней страницы блока) необходимо сделать раздвижку по 7 мм. Итого – 14 мм. Это поле будет являться продолжением изображения (белых полей быть не должно). Если состыковка изображения необходима внутри блока – раздвижка по 5 мм. Итого – 10 мм. 

Фальцовки и биговки.
1. В макете необходимо проставить линии биговок и/или фальцовок при их наличии.
2. При наличии нестандартных фальцовок не забудьте обратить на это внимание менеджера, ведущего ваш заказ.
Пример фальцовки буклета в два сгиба:

	С
	В
	А

	Вн. сторона
	оборот
	лицо




                                                                                         Д

Где Д – общая ширина отпечатанного листа Д=А + В + С (все размеры в мм)
А – ширина первой наружной сторонки, А= (Д / 3) + 1;
В – ширина второй сторонки (оборот), В= А – 0,5;
С – ширина третьей внутренней сторонки, С= А – 2,5.
ВНИМАНИЕ – при размещении оборотной стороны буклета использовать контуры и дизайн лицевой части в зеркальном отображении. Нежелательно размещать на линии фальцовок заливку более 150% красок (суммарная интенсивность CMYK), и размещать ближе 5 мм параллельные линейки, грани, рамки и т.п. Точность выполнения биговок на буклете ± 0,5 мм.

Цветовая модель.
· Используемые в макете цвета должны соответствовать цветовой модели CMYK или Pantone Color Formula Guide. 
· Элементы, которые печатаются цветами Pantone, в макете должны быть отображены Pantone Solid Coated (Uncoated для офсетной бумаги) соответствующего номера.

Нельзя использовать цвета RGB. Перед отправкой файлов в типографию необходимо проверить соответствие используемых цветовых моделей требованиям типографии.

Растровая графика.
1. Разрешение для растровых изображений должно быть 300-400 dpi. Мелкие растровые логотипы, либо мелкие элементы дизайна, вынужденно переведенные в растровое изображение, должны иметь разрешение 600-1200 dpi.
1. Изображения должны быть записаны без лишних alpha channel, без использования JPEG компрессии, приводящей к потере деталей. 
1. Предельное количество краски (total ink limit) для мелованной бумаги – 280%, для немелованной – 240%. Заливок типа С-100 M-100 Y-100 K-100 не должно быть! Самый светлый участок заливки должен иметь минимум 4%.

Графические элементы.
· Композитный черный – С 50%, М 40%, Y 40%, К 100% – для мелованных бумаг, С 40%, М 30%, Y 30%, К 100% – для офсетных бумаг (Рекомендуется).
· Основной черный текст должен быть в одну краску (С 0%, M 0%, Y 0%, K 100%).
· Максимальная сумма красок не более 280%.
· Минимальная толщина одноканальной линии – 0,07 мм. Минимальная толщина линии, окрашенной более чем в одну краску, – 0,13 мм. (Рекомендуется)
· Минимальный размер одноканального текста – 5 pt. Минимальный размер текста, окрашенного более чем в одну краску – 8 pt. (Рекомендуется)
· Разрешение растровых элементов не должно выходить за пределы 300–400 dpi.
· Относительно небольшие объекты черного цвета (текст кеглем до 20 пт, линии и т.д.) должны печататься поверх остальных изображений (overprint). Большие объекты черного цвета (текст больших кеглей, большие плашки) необходимо раскрашивать в «глубокий черный». В противном случае плашка будет либо «серая», либо «прозрачная», т.е. из-под нее будет проглядывать фон.

В макете не должно быть лишних, неверных, случайных установок overprint, так как при цветоделении они сохраняются.

Требования к PDF-файлам
Файлы должны быть композитными и сохранены в версии PDF 1.3. Данная версия PDF не поддерживает использование эффектов прозрачности и смешения цветов (blending mode), поэтому при записи все эффекты преобразуются в простые объекты. Не используйте эффекты прозрачности в объектах, окрашенных смесевыми красками (Pantone и т.п.), такие объекты могут быть напечатаны красками CMYK. В файле не должно быть внедренных ICC-профилей. PDF файл должен быть записан в дообрезном формате, без меток реза, шкал и приводных крестов.
Все используемые шрифты должны быть внедрены в файл. Все изображения внедрены в файл без функции OPI. Внутри обрезного формата страницы и вылетов за обрез не должно быть объектов комментирования PDF-файлов.
Желательно, чтобы PDF-файлы соответствовали стандарту PDF/X-1a:2001.

Требования к EPS-файлам
При записи EPS-файла необходимо, чтобы размер страницы соответствовал обрезному формату изделия. Весь текст должен быть преобразован в векторные объекты («в кривые»). При записи EPS-файла из Photoshop выбирайте настройки — Photoshop DCS 2; preview: TIFF 8 bit; DCS: Single File with Color Composite; Encoding: Binary. Параметры Halftone Screen, Transfer Function, PostScript Color Management задавать не следует. 

Требования к файлам растровых изображений JPEG, TIFF, PSD
Файлы должны быть в цветовых режимах Bitmap, Grayscale, CMYK, Multichannel, Duotone. При использовании JPEG-сжатия учтите, что качество изображения понижается и на изображении появляются артефакты. Файлы TIFF и PSD должны содержать только один слой (в Photoshop команда Layer>Flatten Image). Все неиспользуемые пути, spot-каналы и alpha-каналы необходимо удалить. При наличии в изображении слоев с эффектами очень велика вероятность сбоя при выводе документа на формы или пленки. 

Требования к файлам Adobe InDesign
При подготовке файлов не должны быть задействованы нестандартные модули (plugins), отсутствующие в стандартной поставке. Если дополнительные модули необходимы, то передавайте в типографию PDF-файл. Перед отправкой в типографию обязательно выполните проверку файла верстки командой File>Preflight. В окне отчета вы увидите информацию обо всех используемых шрифтах, красках и внешних подверстанных файлах. Там же будет информация о возможных проблемах, таких как отсутствие необходимых шрифтов или подверстанных файлов. Растровые и графические элементы не должны быть вставлены в макет через буфер обмена или OLE-связью.
Сборку файлов для отправки в типографию выполните командой File>Package, далее в настройках установите все галочки, тем самым включив в сборку все файлы, шрифты и необходимые настройки переноса текста. 

Требования к файлам Adobe Illustrator
Весь текст следует перевести в графические объекты («в кривые»). Задайте настройки растрирования эффектов Effect>Document raster effect settings: CMYK, 150ppi; File>Transparency flattener presets: High Resolution. 

Требования к файлам CorelDRAW
Перед отправкой в типографию проверьте документ командой File>Document info. Сборка файлов производится командой File>Prepare for service bureau. При подготовке файлов не задавайте толщину линий Hairline – укажите толщину линий явно (0,07-0,13 мм). Весь текст желательно перевести в графические объекты («в кривые»). 
· В публикации, подготовленной в СоrelDRAW, не допускается присутствие растровой графики с прозрачным фоном (помещенных файлов в формате PSD).
· Не допускается наличие следующих эффектов: Transparency, Lens, Texture fill и Postscript fill. Все вышеперечисленные эффекты должны быть конвертированы в CMYK – bitmap 300 dpi.
· Эффекты в программе CorelDRAW (Blend, Drop Shadow и т.п.) должны быть сепарированы, в противном случае дизайнер оставляет за собой право вносить подобные коррективы в макет Заказчика. 
· Для того, чтобы тень объекта была корректно цветоделена и соответственно отпечатана, необходимо после ее отделения от объекта применить эффект прозрачности. 
· Градиентные заливки, более чем 96 шагов, необходимо перевести в растровое изображение с разрешением 300 dpi;

Спецотделка (подготовка выборочного лакирования и высечки)
В файле макета области для выборочного лакирования и контуры штампа должны находиться на отдельном слое документа и быть окрашены в 100% Black (название краски должно отражать суть отделки – «LAK», «varnish», «cut», «vyrubka» и т.п.) и им должен быть назначен атрибут Overprint. Лак не должен содержать полутонов, только 0% – лака нет и 100% – лак есть. Точность нанесения лака ± 0,2 мм.

Дополнения
1. При цветоделении типография сохраняет все установки overprint в макете, расставленные дизайнером. В том случае, если их нужно игнорировать, следует указать это в пояснительной записке или сопроводительном файле. Ошибочные установки overprint, выявленные на пленках, исправляются и перевыводятся за счет заказчика (в том числе overprint white).
2. Заказчик предоставляет распечатку окончательного варианта макета (желательно в цвете) со своей подписью. 
· в распечатанном макете должна быть четко указана последовательность страниц в издании;
· при использовании дополнительных красок, на макете должны быть выделены элементы, которые печатаются дополнительным цветом, с указанием точного номера цвета Pantone;
· распечатка должна хорошо читаться;
· макет должен быть полным, не должен содержать пустых полос;
· макет не должен содержать редакторской и корректурной правки и должен быть подписан в печать ответственным за издание лицом с указанием даты подписания. 
3. Перед подготовкой макета Заказчику желательно связаться со специалистом по допечатной подготовки и задать интересующие вопросы.
4. Проверка файлов заказчика рекомендациям ОДП (пункты с пометкой Рекомендуется) не является обязательной. Если поступившие файлы не соответствуют ОДП, сотрудники типографии не несут ответствкености за возникшие в связи с этим недостатки печати.



ПОДПИСИ СТОРОН
	от Исполнителя

_______________________/А.В. Беляев/
             М.П.

	от Заказчика

___________________/ _____________________/          
           М.П.








Приложение №3
к договору №_____ от «_____» ________________  2021г. 


Критерии оценки качества
полиграфической продукции




0. СОГЛАСОВАНИЕ ТРЕБОВАНИЙ К КАЧЕСТВУ  ПРОДУКЦИИ

Требования к качеству полиграфической Продукции, которое гарантирует ОАО «Алтайский дом печати», прописаны в данном документе.
Если у Заказчика существуют особенные требования к качеству Продукции, отличные от указанных в настоящем документе, то эти требования согласовываются отдельно и фиксируются в Cпецификации конкретного заказа до запуска заказа в производство.
ОАО «Алтайский дом печати» гарантирует, что в момент заключения Договора:
· Требования к качеству каждого конкретного заказа определены и согласованы с Заказчиком.
· В тех случаях, когда результаты каких-либо технологических процессов не могут быть проверены путем измерений, с Заказчиком определяются и согласовываются критерии, на основании которых качество Продукции считается приемлемым.
·       Требования к заказу, отличающиеся от установленных, должны быть согласованы Сторонами.
· Требования, относящиеся к качеству представляемых Заказчиком оригиналов и используемых материалов, согласованы.
·      ОАО «Алтайский дом печати» имеет все необходимые возможности для выполнения определенных требований.

2.  ОБЩИЕ ТРЕБОВАНИЯ К КАЧЕСТВУ ПРОДУКЦИИ
· Тиражные оттиски должны соответствовать подписанным листам и цветопробе (при ее наличии, проверенной и подписанной технологом) по цветовым координатам красок, характеру и размерам элементов изображения.
· На тиражных листах не должно быть отмарывания, непропечатки, смазывания краски, тенения, выщипывания волокон бумаги, масляных пятен, следов рук и других загрязнений, разрывов бумаги, морщин, складок, загнутых углов и кромок. 
· Несовмещение лицевой части печатного листа с оборотом не должно превышать 1 мм. 
· Перекос изображения не может превышать 0,5 мм. 
· Допустимо наличие царапин не более одной на 0,35 м2 печатного листа размером по длине не более 8 мм и ширине не более 0,1 мм, не искажающих текстовой информации или не расположенных на лицах в фотографических участках изображения, а также на имиджевых рекламных блоках.

Допустимо наличие «марашек» (элементов, представляющих собою капли краски или капли смывочного раствора, попавшие на оттиск в процессе печати тиража) на оттиске площадью 0,35 м² печатного листа, в том случае если данный элемент не искажает текстовой информации или не расположен на лицах в фотографических участках изображения, а также на имиджевых рекламных блоках. Пятна относятся к случайным дефектам и входят в суммарный процент несоответствий в тираже.

ТРЕБОВАНИЯ К КАЧЕСТВУ ИСПОЛЬЗУЕМЫХ МАТЕРИАЛОВ И ОРИГИНАЛОВ

· Материалы, применяемые для изготовления Продукции, должны соответствовать требованиям действующих стандартов и технических условий. 
· Качество всех используемых материалов должно быть подтверждено сертификатами качества, гигиеническими сертификатами и сертификатами соответствия.
Принимаемые в производство макеты должны соответствовать Требованиям к исходным материалам Заказчика.


4.  ТРЕБОВАНИЯ К ГОТОВОЙ ПРОДУКЦИИ

· Готовая Продукция должна соответствовать заданному обрезному формату, чертежу с отклонениями не более 1 мм с каждой стороны.
· Косина изделия не должна превышать 1,3 мм.
· Обрезы должны быть гладкими и чистыми.
· Тетради должны быть хорошо скреплены с блоком.
· Косина по корешку не должна превышать 1 мм.
· Тиражные экземпляры не должны иметь механических повреждений.

5. КРИТЕРИИ ОЦЕНКИ КАЧЕСТВА ПЕЧАТНОГО ОТТИСКА
(для листовой офсетной печати)

Критерии оценки качества печатного оттиска включают:
5.1. Допуски на совмещение красок
Максимальное отклонение между центрами изображений для любых двух красок не должно превышать 0,1 мм. 
5.2. Допуски на отклонение при печати
Значения координат в цветовом пространстве CIE L*a*b для плашек, напечатанных триадными красками, на эталонном (подписанном в печать) и тиражном оттисках согласно ГОСТ Р 54766-2011 не должны выходить за пределы допусков, указанных в Таблице 1:
Допустимое значение коэффициента цветового различия ΔЕ (CIELab)
	 
	Голубой (С)
	Пурпурный (М)
	Желтый (Y)
	Черный (K)

	между цветопробой и подписным листом
	5
	5
	5
	5

	между подписным и тиражным листом
	4
	4
	4
	5



Цветовое различие образца смесевого цвета и цвета на подписном (эталонном) оттиске не должно превышать deltaE =3,0. Цветовое различие смесевого цвета между образцом смесевого цвета и тиражным оттиском не должно превышать deltaE=5,0.
В случаях, если образец эталонного цвета не предоставлен Исполнителю, то эталон цвета должен быть идентифицирован по каталогу цвета Pantone Match System. 

5.3. Пределы воспроизведения растровой плотности
Структуры растровых точек должны корректно переноситься на оттиск в следующих пределах растровой плотности:
· при линиатуре 175 lpi – в пределах от 3% до 97%;
· при линиатуре 200 lpi – в пределах от 5% до 95%.
На цветоделенных фотоформах не должно быть значительных участков изображения с растровыми плотностями вне указанных пределов.
5.4. Величины растискивания
Параметры увеличения растровых плотностей (растискивания) должны соответствовать следующим значениям:
Мелованные бумаги (в 40% / 80% растровой плотности).
· Cyan – 16 / 12 ± 4 %.
· Magenta – 16 / 12 ± 4 %.
· Yellow – 16 / 12 ± 4 %.
· Black – 19 / 13 ± 4 %.
Офсетные бумаги (в 40% / 80% растровой плотности).
· Cyan – 19 / 14 ± 4 %.
· Magenta – 19 / 14 ± 4 %.
· Yellow – 19 / 14 ± 4 %.
· Black – 22 / 16 ± 4 %.




6. ТРЕБОВАНИЯ К ЛАКИРОВАНИЮ ОТТИСКОВ
· Тиражные оттиски, покрытые лаком (Офсетным и УФ) не должны содержать царапин, заломов, отслоения лакового слоя, дополнительных включений, нарушающих равномерность лакового покрытия.
· Отклонение по точности приводки (совмещения) выборочного УФ-лакирования с печатным изображением — до 1,5 мм. 
· Допускается наличие следов пальцев рук на Продукции, покрытой матовым, глянцевым УФ-лаком. Продукцию на матовых бумагах и бумагах массой свыше 200 г/м2, печатающуюся на листовом участке, рекомендуется покрывать офсетным лаком для сохранения высокого качества Продукции и сокращения срока выполнения работ. В случае отказа от лакировки Продукции (особенно обложек) на матовых бумагах и бумагах массой свыше 200 г/м2 возможно возникновение дефектов механического характера (царапины, следы от проводящих лент и валов, истирание). Кроме того, сроки прохождения подобных заказов оговариваются Сторонами особо.

7. КРИТЕРИИ ОЦЕНКИ КАЧЕСТВА ПОСТПЕЧАТНЫХ РАБОТ
7.1. Тиснение изделий фольгой, конгревное тиснение
При тиснении допускается несовпадение тиснения с рисунком до ±0,5 мм (разброс в тираже до 1 мм).
При тиснении на 5 % тиража допускаются: 
· незначительные марашки и пробелы на плашках размером до 0,5 мм;
· непроработка мелких деталей;
· затекание мелких пробельных элементов (0,5 мм);
· незначительная неровность края тиснения. 
При конгреве допускается несовпадение рельефного изображения с рисунком до ±0,5 мм (разброс в тираже до 1 мм). 
При конгреве на 5% тиража допускаются : 
· неполная проработка деталей (при размере элементов не менее 0,5 мм, если элементы менее 0,5 мм, то неполная проработка допускается на 50% листа);
· неравномерное распределение давления по листу;
· механические повреждения бумаги. 
7.2. Вырубка изделий
При вырубке допускается несовмещение с рисунком: 
· при размерах вырубки до формата А5 —  0,5 мм; 
· при размерах вырубки до формата А3 —  0,7 мм; 
· при форматах свыше А3  — 0,8 мм.
Допустимый процент несоответствий в тираже – 5% от общего количества.
При вырубке на 5% тиража допускаются:
· повреждения материала на биговках длиной до 5 мм;
· расслоение картона  по краю реза до 10 мм.
7.3. Печать по металлизированным материалам
•    При печати по металлизированным цветопередача не соответствует печати по бумаге. Цветовая проба для линзового материала невозможна. 
•    На равномерных плашках возможно проявление разводов в цвете на тираже (проявление статики).
•    Допустимо присутствие марашек диаметром не более 0,3 мм и царапин не более 5 мм на 0,35 м2 площади печатного листа.
8. ДОПОЛНИТЕЛЬНЫЕ ТРЕБОВАНИЯ
Исполнитель оставляет за собой право изменять параметры полиграфической Продукции с целью обеспечения требований к качеству полиграфической Продукции в соответствии с настоящим Приложением только по согласованию с Заказчиком.
Исполнитель заранее информирует Заказчика о возможных проблемах и учитывает при приеме заказа и расчете цены следующее: 
· Если работа содержит растровый текст, не переведенный в контурное изображение, при печати возможно несовмещение и наличие «рваных» краев текста. 
· На работы на бумаге с запечаткой более 70% с последующей постпечатной обработкой необходимо нанесение офсетного лака во избежание отмарывания. 
· При сборке работ, отпечатанных на дизайнерской бумаге, особенно при сборке Продукции клеевым способом, необходимо предварительное изготовление «сигнального» образца. 
· Если в Продукции есть лист, тетрадь или обложка с клапанами, размер листа (тетради, обложки) должен быть минимум на 2-3 мм меньше блока по фронтальному резу. 
· При печати на невпитывающих материалах, некоторых видах дизайнерских бумаг, кальках, пленках, бумагах, запечатанных металлизированными пантонами, используются фолиевые краски. При печати фолиевыми красками необходимо согласование выбора бумаги с Исполнителем. Также необходимо учитывать, что минимальное время для сушки тиражей — 48 часов; а также необходимо время (до 6 суток для некоторых материалов) на акклиматизацию входных печатных материалов в цеховых условиях. 
· Для печати 1+1 возможно использование бумаги плотностью от 65 г/м2. Для полноцветной печати такая бумага непригодна. 
                                                   



ПОДПИСИ СТОРОН



	от Исполнителя

_______________________/А.В.Беляев/     
                         М.П.
	от Заказчика

_____________________ /____________________________/                            
                      М.П.









































Приложение № 4
к Договору №_____ от
 «______» ________________ 2021 г.

Спецификация №___  (Форма)
к Договору №_______ от «______» _______________ 2021 г.

Исполнитель ОАО «Алтайский дом печати», в лице Генерального директора Беляева Александра Вениаминовича, действующего на основании Устава, с одной стороны, и Заказчик _____________________________________________________________________________, в лице __________________________________________________, действующего на основании _________________________________, с другой стороны, заключили настоящее Приложение к Договору о нижеследующем:
Заказчик поручает, а Исполнитель принимает на себя работы по изготовлению полиграфической продукции согласно настоящей Спецификации:

1. Наименование Продукции:. 
2. Тип картона и плотность:.
3. В каком виде предоставляется (разрабатывается) оригинал-макет: электронный оригинал- макет Заказчика.
4. Дата выполнения работ (изготовления Продукции):.
5. Условия  оплаты:.
6. Условия доставки:.
7. Как упаковывается Продукция:.
8. Производимые операции:.
9. Тираж, цена и стоимость Продукции:.


	№
п/п
	Наименование
	Ед. изм.
	Тираж
	Цена
руб.
	Ставка НДС
%
	Сумма НДС
	Всего с НДС
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ПОДПИСИ СТОРОН

	от Исполнителя

_______________________/А.В.Беляев/
                         М.П.


	от Заказчика

_____________________ /______________________/                            
                      М.П.






____________________   А.В.Беляев	                   ____________________   

